Configuring Inova IT SIP Objects.NET and Inova IT Click2Call with Avaya SIP Application Server, Avaya Communication Manager, and Avaya SIP Enablement Services – Issue 1.0

Abstract

These Application Notes describe the steps to configure Inova IT SIP Objects.NET and the Inova IT Click2Call application to work with an environment comprised of Avaya SIP Application Server (SIP A/S), Avaya Communication Manager, and Avaya SIP Enablement Services.

The Inova IT Click2Call application enables the use of Microsoft Internet Explorer and Microsoft Office applications to establish a call between two endpoints. This application is built on top of the Inova SIP Objects.NET platform which uses the Open Web Services deployed on Avaya SIP A/S. For these Application Notes, the Inova IT Click2Call application was tested with Microsoft Internet Explorer, Microsoft Excel, and Microsoft Word.

Information in these Application Notes has been obtained through DevConnect compliance testing and additional technical discussions. Testing was conducted via the DevConnect Program at the Avaya Solution and Interoperability Test Lab.
1. Introduction
These Application Notes describe the steps to configure Inova IT SIP Objects.NET (SO.NET) and the Inova IT Click2Call 1.3.187 application to work with an environment comprised of Avaya SIP Application Server (SIP A/S), Avaya Communication Manager, and Avaya SIP Enablement Services (SES).

1.1. Background
In the sample configuration, there are several components that are installed on the Avaya SIP A/S platform. The Service Oriented Object Framework (SOOF), also known as SIP Service Oriented Architecture (SOA), is a SOA-based application development and deployment framework that is deployed on top of Avaya SIP A/S. SOOF/SIP SOA includes a suite of re-usable SIP Service Components including Open Web Services (OWS). OWS exposes some of the underlying Service Component functionality as web services according to the Parlay X 2.0 API [12].

OWS provides a Third Party Call Control (3PCC) service that uses the Parlay X 2.0 3PCC API. The Third Party Call Control service allows applications to establish a call between two endpoints. The Inova IT Click2Call application (also referred to as “Click2Call” in this document) is built using the Inova IT SO.NET Framework. The SO.NET framework allows applications like Click2Call to access OWS. Through SO.NET, Click2Call is able to use the Third Party Call Control service to make a call between two endpoints. Other applications can be developed using SO.NET (see References [11] and [13]).

These Application Notes focus on the following:
- The configuration of the SIP trunks between Avaya Communication Manager and Avaya SES to support calls from Avaya SIP A/S.
- The configuration of Avaya SIP A/S to support the OWS Third Party Call Control service.
- The configuration of SO.NET and Click2Call to use the OWS Third Party Call Control service to work with Avaya Communication Manager endpoints.
- The configuration of the Microsoft Internet Explorer and Microsoft Office applications to work with Click2Call.

For administration of endpoint telephones and general administration of Avaya Communication Manager and Avaya SES, refer to the appropriate documentation listed in Section 12.
1.2. Network Configuration

These Application Notes present a sample configuration for the network shown in Figure 1. For the sample configuration, Avaya Communication Manager is running on the Avaya S8300 Server with an Avaya G700 Media Gateway. The results in these Application Notes are applicable to other Avaya servers and gateways. Avaya SIP A/S is configured in a single-box deployment where all of the cluster elements (one Management Server, one Service Director, and one Service Host) are on a single hardware platform. Oracle Database 10g Express Edition is used as the database for Avaya SIP A/S and is installed on the same server PC as Avaya SIP A/S.

SIP trunks are used to connect Avaya Communication Manager and Avaya SIP A/S via Avaya SES. All calls established by Click2Call, via the Third Party Call Control service running on Avaya SIP A/S, are carried over these SIP trunks.

As shown in Figure 1 and listed in Table 1, there are several Avaya Digital, H.323, and SIP telephones that are connected to or registered with Avaya Communication Manager or Avaya SES. Additionally, there is a connection from Avaya Communication Manager to the Public Switch Telephone Network (PSTN) to establish calls with PSTN telephones. With the exception of the Digital and the PSTN telephones, all components are connected to a single Avaya C364T-PWR Converged Stackable Switch.
Figure 1: Network Configuration Diagram
2. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya S8300 Server with Avaya G700 Media Gateway</td>
<td>Avaya Communication Manager 5.0 R015x.00.0.825.4</td>
</tr>
<tr>
<td>Avaya SIP Enablement Services</td>
<td>5.0, SES-5.0.0.0-825.31</td>
</tr>
<tr>
<td>Avaya SIP Application Server</td>
<td>7.2.11</td>
</tr>
<tr>
<td>Service Oriented Object Framework</td>
<td>1.1.5</td>
</tr>
<tr>
<td>Service Components</td>
<td>1.5.2</td>
</tr>
<tr>
<td>Open Web Services</td>
<td>1.1.0</td>
</tr>
<tr>
<td>Sun Microsystems Java</td>
<td>1.5.0</td>
</tr>
<tr>
<td>on Dell Precision 380</td>
<td>Microsoft Windows 2003 Server, Service Pack 2</td>
</tr>
<tr>
<td>Avaya 4610SW IP Telephone</td>
<td>2.8 (H.323)</td>
</tr>
<tr>
<td></td>
<td>3.1.0 (Avaya Quick Edition)</td>
</tr>
<tr>
<td>Avaya 4621SW IP Telephone</td>
<td>2.8 (H.323)</td>
</tr>
<tr>
<td></td>
<td>2.2.2 (SIP)</td>
</tr>
<tr>
<td></td>
<td>3.1.0 (Avaya Quick Edition)</td>
</tr>
<tr>
<td>Avaya 9620 IP Telephone</td>
<td>2.0.1.34 (Avaya one-X™ Deskphone SIP)</td>
</tr>
<tr>
<td>Avaya 9630 IP Telephone</td>
<td>2.0.1.34 (Avaya one-X Deskphone SIP)</td>
</tr>
<tr>
<td>Avaya 6408D+ Digital Telephone</td>
<td>N/A</td>
</tr>
<tr>
<td>Avaya C364T-PWR Converged Stackable Switch</td>
<td>4.5.14</td>
</tr>
<tr>
<td>Inova IT Click2Call</td>
<td>1.3.187</td>
</tr>
<tr>
<td>on Dell Precision 370</td>
<td>Microsoft Windows XP Professional, Service Pack 2</td>
</tr>
<tr>
<td>Microsoft Internet Explorer</td>
<td>7.0.5730.13</td>
</tr>
<tr>
<td>Microsoft Excel 20003</td>
<td>11.8169.8172, SP3</td>
</tr>
<tr>
<td>Microsoft Word 20003</td>
<td>Microsoft Windows XP Professional, Service Pack 2</td>
</tr>
<tr>
<td>on Dell Precision 370</td>
<td>11.8169.8172, SP3</td>
</tr>
<tr>
<td>Oracle Database 10g Express Edition on Dell Precision 380</td>
<td>2</td>
</tr>
</tbody>
</table>

Table 1: Configuration Equipment and Version
3. Avaya Communication Manager Configuration

The configuration of Avaya Communication Manager and the endpoints that connect to Avaya Communication Manager is not the focus of these Application Notes. This configuration information is provided in References [1-3]. For these Application Notes, it is assumed that Avaya Communication has already been configured for SIP connectivity to Avaya SES and that all of the endpoints shown in Figure 1 and the PSTN trunk have been configured.

In this sample configuration, a five digit Uniform Dial Plan (UDP) was used for internal calls (25xxx for Avaya Quick Edition endpoints, 26xxx for SIP endpoints, 300xx for H.323 endpoints, and 301xx for Digital endpoints). For external calls to the PSTN, an 11-digit dial plan was used (1 732 852 1xxx). The Click2Call application only supports numbers in the E.164 format (see Sections 7.1 and 7.2.1). For this configuration, 11-digit numbers are used for the E.164 format (for the numbering format supported in the United States). As the 11-digit dial plan used by Avaya Communication Manager applies only for PSTN calls, some of the 11-digit numbers dialed by Click2Call were mapped to internal 5-digit numbers as shown in Section 3.2.

These Application Notes assume that the following procedures have already taken place:

- All Digital, H.323, and SIP stations have been configured.
- The SIP trunk between Avaya Communication Manager and Avaya SES has been configured to support trunking between the two systems and to support the SIP endpoints registered with Avaya SES.
- The PSTN trunk has been configured.
- Routing to the PSTN has been configured. For this sample configuration, Automatic Route Selection (ARS) was used to route calls to the PSTN trunk.

This section focuses on the configuration of the SIP trunk used for the calls generated by Avaya SIP A/S on behalf of the Click2Call application. As this version of the Click2Call application only supports numbers that are formatted in the E.164 format (see Reference [14]), such as “1 732 852 6005”, the internal endpoints were mapped to 11 digit numbers. This section also focuses on the digit manipulation required to map the 11-digit numbers dialed by the Click2Call application to a 5-digit internal extensions, as appropriate.

For ease of configuration, all components are configured to use IP network region “1” and IP codec set “1”. Media shuffling (direct IP-IP media) is enabled. Codec set “1” has “G.711MU” and “G.729AB” codecs configured.

To configure the SIP trunk and to map the 11-digit numbers to the 5-digit internal extensions, the following procedures were used:

- Configure SIP trunk group and signaling group
- Configure incoming call handling treatment

The following configuration of Avaya Communication Manager was performed using the System Access Terminal (SAT). After completion of the configuration in this section, use the “save translation” command to make the changes permanent.
3.1. Configure SIP Trunk Group and Signaling Group

In the sample configuration, trunk group “1” and signaling group “1” were used to reach SIP endpoints registered with Avaya SES. Trunk group “3” and signaling group “3” were added to reach Avaya SIP A/S.

Administer a SIP signaling group to use for signaling. Use the “add signaling-group n” command, where “n” is an available signaling group number. Enter the following values for the specified fields and retain the default values for all remaining fields. Submit these changes.

- **Group Type:** “sip”
- **Transport Method:** “tls”
- **Near-end Node Name:** System processor node name “procr”, as was configured in the IP Node Names form for this sample configuration.
- **Far-end Node Name:** Avaya SES node name “sesisv”, as was configured in the IP Node Names form for this sample configuration.
- **Near-end Listen Port:** “5061”
- **Far-end Listen Port:** “5061”
- **Far-end Network Region:** Network region number “1”, as was configured for this sample configuration.
- **Far-end Domain:** SIP domain name of Avaya SIP A/S from Section 5.1.
- **DTMF over IP:** “rtp-payload”

```plaintext
add signaling-group 3

SIGNALING GROUP

Group Number: 3
Group Type: sip
Transport Method: tls

Near-end Node Name: procr
Near-end Listen Port: 5061
Far-end Node Name: sesisv
Far-end Listen Port: 5061
Far-end Network Region: 1
Far-end Domain: isvsipas.com

Bypass If IP Threshold Exceeded? n
DTMF over IP: rtp-payload
Direct IP-IP Audio Connections? y
IP Audio Hairpinning? n
Enable Layer 3 Test? n
Session Establishment Timer(min): 3
```
Use the “add trunk-group n” command, where “n” is an available trunk group number. Enter the following values for the specified fields and retain the default values for the remaining fields. Submit these changes.

- **Group Type:** “sip”
- **Group Name:** A descriptive name.
- **TAC:** An available trunk access code.
- **Service Type:** “tie”
- **Signaling Group:** Signaling group number for newly created signaling group.
- **Number of Members:** Desired number of trunk group members.

```
add trunk-group 3

TRUNK GROUP

Group Number: 3
Group Name: SIP A/S 150.1.1.161
Group Type: sip
CDR Reports: y
COR: 1
TN: 1
TAC: #03
Direction: two-way
Outgoing Display? n
Dial Access? n
Queue Length: 0
Service Type: tie
Auth Code? n

Signaling Group: 3
Number of Members: 10
```

### 3.2. Configure Incoming Call Handling Treatment

As shown in **Section 3**, the internal extensions are within the ranges 25xxx, 26xxx, and 30xxx and the PSTN endpoints are within the range 1 732 852 1xxx. As described in **Section 4.2**, the Click2Call application only supports telephone numbers that are consistent with the E.164 specification (see Reference [14]). It is not possible to use the 5-digit internal dial plan format with the application. For this configuration, digit manipulation was performed for the incoming calls to map certain 11-digit numbers to 5-digit internal numbers. This was the routing that was performed for this configuration; other routing rules may be used.

For this configuration, the mapping was as follows:

- Calls made to “1 732 852 5xxx” were mapped to “25xxx”
- Calls made to “1 732 852 6xxx” were mapped to “26xxx”
- Calls made to “1 732 853 xxxx” were mapped to “3xxxx”
Use the “change inc-call-handling-trmt trunk-group n” command, where “n” the trunk group number configured in Section 3.1 for calls to and from Avaya SIP A/S. Enter the following values for the specified fields and retain the default values for the remaining fields. Submit these changes.

- **Called Len:** “11”; length of the numbers delivered by the Click2Call application.
  
  **NOTE:** International numbers were not tested in this configuration.

- **Called Number:** A matching pattern for the number that was dialed, e.g., “1732853”.

- **Del:** “6”; remove the first 6 numbers so that only the 5-digit extension remains.

<table>
<thead>
<tr>
<th>Service/Feature</th>
<th>Called Len</th>
<th>Called Number</th>
<th>Del</th>
<th>Insert</th>
</tr>
</thead>
<tbody>
<tr>
<td>tie</td>
<td>11</td>
<td>17328525</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>tie</td>
<td>11</td>
<td>17328526</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>tie</td>
<td>11</td>
<td>1732853</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

### 4. Avaya SIP Enablement Services Configuration

This section provides the procedures for configuring SIP trunking between Avaya SES and Avaya SIP A/S. Other standard configuration information is covered in Reference [1]. It is assumed that Avaya SES is already installed and configured for connectivity with Avaya Communication Manager. It is assumed that Avaya SES has already been configured with domain and host information. It is also assumed that all SIP endpoints are administered.

The procedures in this section are used to configure the SIP trunk between Avaya SES and Avaya SIP A/S to allow the calls initiated by the Click2Call application to reach Avaya SES and to terminate on Avaya Communication Manager. As all SIP endpoints are registered with Avaya SES, Avaya SES knows how to handle calls to the SIP endpoints. As the Digital, H.323, and PSTN endpoints do not register with Avaya SES, additional configuration is needed to instruct Avaya SES to deliver the SIP INVITE messages for these endpoints to Avaya Communication Manager. This additional configuration is achieved by a media server address map, also covered in Reference [1] and shown in Section 4.2. To support the Click2Call application, another media server address map is required to address the fact that the application dials only 11-digit numbers in this configuration (see Section 4.2).

The procedures include the following areas:

- Configure media server address map for Click2Call
- Configure trusted host for Avaya SIP A/S

**NOTE:** For this sample configuration, the SIP domain “isvabc.com” was configured for Avaya SES. This value is used for configuring the Click2Call application settings in Section 7.1.
4.1. Avaya SIP Enablement Services Administration Web Interface

Access the Avaya SES administration web interface by using the URL “http://<ip-address>/admin” in an Internet browser window, where “<ip-address>” is the IP address of Avaya SES. The IP address for Avaya SES may vary. In the sample configuration, “150.1.1.150” was used, as shown in Figure 1. Log in with the appropriate credentials and click the Launch SES Administration Interface link.

The Top window is displayed, as shown below.
4.2. Configure Media Server Address Map for Click2Call Calls

To ensure that calls from the Click2Call application are routed to Avaya Communication Manager, ensure that a media server address map is created. As the Click2Call application only supports numbers that are in the E.164 format (see Reference [14]), all calls from the Click2Call application will be dialed as 11-digit numbers. Calls to Avaya Quick Edition endpoints (25xxx), SIP endpoints (26xxx), Digital endpoints (301xx), H.323 endpoints (300xx), as well as the PSTN endpoints (1 732 852 1xxx) are represented as 11-digit numbers. The mapping defined in Section 3.2 will be used to direct calls to the internal endpoints, as appropriate.

As mentioned in Section 4, address maps were created in this sample configuration to allow SIP endpoints to call non-SIP endpoints. To view the configuration information on these address maps and to configure the new address map, select Media Servers ➔ List from the left-hand pane of the Top window. The List Media Servers window is displayed. Click the Map link in the right-hand pane.
In the List Media Server Address Map window below, the two address maps that are used to reach non-SIP endpoints are listed: “30xxx” and “PSTN”. These address maps are used to reach internal stations within the range 30000-30999 and telephones on the PSTN (for numbers dialed as “917328521xxx”). Also listed is the Contact address associated with these two address maps: “sip:$\text{(user)}@150.1.1.100:5061;transport=tls”.

To configure the new address map, click the Add Another Map link associated with the two address maps. The Add Media Server Address Map window is displayed. For the Name field, enter a descriptive name to denote the routing. For the Pattern field, enter an appropriate syntax for the address mapping. A pattern of “^\text{sip:}\{+[+]*173285\}” was used to match to any number starting with “+173285” or with “173285”. Retain the check in Replace URI and click Add.
Click **Continue** on the **Continue** window that confirms that the address map was added (not shown). An updated **List Media Server Address Map** window is displayed. The address map that was just added is shown.

![AVAYA Integrated Management](image)

### 4.3. Configure Trusted Host

Administer Avaya SIP A/S as a trusted host so that Avaya SES will not challenge the SIP messages from Avaya SIP A/S. From the **Top** window, select **Trusted Hosts ➔ Add** from the left-hand pane to display the **List Trusted Hosts** window.

![AVAYA Trusted Hosts](image)
The Add Trusted Host window is displayed next. For the **IP Address** field, enter the IP Address of Avaya SIP A/S (shown in Figure 1). For the **Comment** field, enter a descriptive name. Click **Add**.

Click **Continue** on the **Continue** window that confirms that the trusted host entry was added (not shown). An updated **List Trusted Hosts** window is displayed.
5. Avaya SIP Application Server Configuration

The installation and configuration of Avaya SIP A/S are covered in References [5] and [6], respectively. For this sample configuration, Avaya SIP A/S was installed on a system running the Microsoft Windows operating system. It is assumed that Avaya SIP A/S has been installed and licensed. The Avaya SIP A/S used in this configuration is on a single-box deployment where all of the cluster elements (one Management Server, one Service Director, and one Service Host) are on a single hardware platform.

In addition to the Avaya SIP A/S platform, the following components are all assumed to be installed.

- SIP Service Oriented Architecture 1.1 [5]
- Service Components Start-up Pack 1.5 [7]
- Open Web Services Add Pack 1.1 [9]
- SIP A/S Element Manager [5]
- Oracle Database 10g Express Edition [15]

**NOTE**: Oracle Database 10g Express Edition is the database that was used in this sample configuration. Other databases are supported by Avaya SIP A/S and can be used. The installation and configuration of Oracle Database 10g Express Edition are not the focus of these Application Notes and are not covered.

This section focuses on the procedures to configure Avaya SIP A/S to support the Third Party Call Control service, which is required by the Click2Call application. The Third Party Call Control service is included in Open Web Services. The procedures are as follows:

- Display initial configuration parameters
- Deploy extension and services
  - Deploy Distributed State Management (DSM)
  - Deploy Service Components
  - Deploy Open Web Services
- Configure SOOF aliases
  - Configure Service Components aliases
  - Configure Open Web Services aliases
The configuration of Avaya SIP A/S was performed using the SIP A/S Element Manager application. As Avaya SIP A/S is installed on a Microsoft Windows platform for this sample configuration, access the SIP A/S Element Manager by selecting Start → Programs → Ubiquity → Ubiquity Element Manager → Ubiquity Element Manager. The SIP A/S Element Manager window is displayed.

For the procedures covered in this section, it is assumed that a cluster has been configured and connected to the Management Server, a Service Director is connected, a Service Host has been connected, and a channel has been connected to the Service Host. For the compliance test, the cluster name “SIP_AS_72” was used. For more information on the configuration and management of Avaya SIP A/S, see Reference [6].
5.1. Display Initial Configuration Parameters

This section summarizes the parameters configured during the Avaya SIP A/S installation procedures (see References [5] and [6]), that are used for configuring the SIP trunk with Avaya SES (see Sections 3.1 and 4.3) and for configuring the DSM extension (see Section 5.2.1).

Navigate to the Service Host Collection Configuration tab by selecting Ubiquity Services → SIP_AS_72 → Connected to SIP A/S Management Server → Service Host Collection and then clicking the Configuration tab. Controlled Domains contains the SIP domain that is controlled by Avaya SIP A/S. NOTE: The IP address for Avaya SIP A/S is also used for the SIP domain.

The other fields in this screen were populated as part of the initial installation and configuration. The RDMBS Connection String and RDMBS Driver fields are specific for the connection to the Oracle database. The RDMBS Connection String value is used in the configuration in Section 5.2.1. These values will vary depending on the database that is used.
5.2. Deploy Extension and Services
To support the Click2Call application, the DSM extension and two Avaya SIP A/S services must be deployed. The extension and the services are installed with Avaya SIP A/S, Service Components, and Open Web Services, respectively.

5.2.1. Deploy Distributed State Management Extension
Access the Extensions tab for the Service Host Collection in the SIP A/S Element Manager window. From left-hand pane for the SIP A/S Element Manager window shown in Section 5.1, select Ubiquity Services → SIP_AS_72 → Connected to SIP A/S Management Server → Service Host Collection. Click the Extensions tab and then click Configure. Select “dsm_database.jar” in the Installed Extensions frame. Click the button between the Installed Extensions and Deployed Extensions frames.

The Enter binding name dialogue box is displayed. Retain the value for the field. Click OK.

The Extension Management dialogue box is displayed. Click Yes to continue with the deployment of the extension.
The `dsm_database.jar` dialogue box is displayed. Enter the parameters as described below and retain the default values for the remaining fields. Click **Apply**.

- **RDBMS Connection String**: “jdbc:oracle:thin:UserName/PassWord@localhost:1521:XE” (see Section 5.1)
- **User ID**: “UserName” (the user name in the RDBMS Connection String in Section 5.1).
- **Password**: “PassWord” (the password in the RDBMS Connection String in Section 5.1).

A confirmation dialogue (**Important Information**) is then displayed indicating that configuration changes have been applied to the cluster (not shown). Click **OK**.

### 5.2.2. Deploy Service Components

Based on the recommendation from References [8], the “bundled” Service Components service file (“service_components.sar”) was used for this sample configuration. If necessary, the Service Components can be deployed as individual services using individual files for each service (e.g., “call.sar”, “incoming_dialog.sar”, etc.).
Access the Applications tab for the Service Host Collection in the SIP A/S Element Manager window. From left-hand pane for the SIP A/S Element Manager window shown in Section 5.1, select Ubiquity Services → SIP_AS_72 → Connected to SIP A/S Management Server → Service Host Collection. Click the Applications tab and then click Configure. Scroll down the list in the Application Repository frame and select “service_components.sar”. Click the button between the Application Repository and Deployed Applications frames and click Apply.

A confirmation dialogue (Deploy service_components.sar) is then displayed indicating that the service is being provisioned (not shown). Then the Configuration for service_components.sar dialogue is displayed. Retain the default values for the fields and click Apply.
A confirmation dialogue (Deploy service_components.sar) is then displayed indicating that the service is being deployed (not shown). A confirmation dialogue (Important Information) is then displayed indicating that configuration changes have been applied to the cluster (not shown). Click OK. The “service_components.sar” service is then displayed in the Deployed Applications frame (see Section 5.2.3).

5.2.3. Deploy Open Web Services

Based on the recommendation from Reference [10], the “bundled” Open Web Services service file (“parlayx_components.sar”) was used for this sample configuration. If necessary, Open Web Services can be deployed as individual services using individual files for each service (e.g., “parlayx_threepcc.sar”, “parlayx_audiocall.sar”, etc.).

Access the Applications tab for the Service Host Collection in the SIP A/S Element Manager window. From left-hand pane for the SIP A/S Element Manager window shown in Section 5.1, select Ubiquity Services → SIP_A/S_72 → Connected to SIP A/S Management Server → Service Host Collection. Click the Applications tab and then click Configure. Scroll down the list in the Application Repository frame and select “parlayx_components.sar”. Click the button between the Application Repository and Deployed Applications frames and click Apply.

A confirmation dialogue (Deploy parlayx_components.sar) is then displayed indicating that the service is being provisioned (not shown).
Then the Configuration for parlayx_components.sar dialogue is displayed. The parameters listed below were used for the sample configuration. Retain the default values for the remaining fields. Click Apply.

- **SIP From Address**: “sip:FromAddr@isvsipas.com”
- **SIP From Address For Calling Party**: “sip:CallingPartyFromAddr@isvsipas.com”
- **The ‘From Address’ to appear in all outgoing SIP dialogs**: “sip:OutgoingFromAddr@isvsipas.com”
- **Rule Management Component Alias**: “parlayx_call_handling_RuleManagement”
- **SIP From Address For Called Party**: “sip:CalledPartyFromAddr@isvsipas.com”
The SIP URIs shown in the above configuration include “isvips.com” which represent the domain name of Avaya SIP A/S as shown in Section 5.1. These values were used for demonstration purposes to clearly identify the type of SIP “From” address was being used.

**NOTE:** The SIP “From” headers in this configuration do not include a “display name” as “display name” is not supported for the Open Web Services configuration. Usually, the SIP “From” header is in the form of “User Name <sip:User@domain-name>’, where “User Name” is the “display name”.

A confirmation dialogue (Deploy parlayx_components.sar) is then displayed indicating that the service is being deployed (not shown). A confirmation dialogue (Important Information) is then displayed indicating that configuration changes have been applied to the cluster (not shown). Click OK.

### 5.3. Configure SOOF Servlet Aliases

Once the services listed in Section 5.2 have been deployed, SOOF servlet aliases must be configured for the deployed services.

#### 5.3.1. Configure Service Components Aliases

Access the SOOF tab for the Service Host Collection in the SIP A/S Element Manager window. From left-hand pane for the SIP A/S Element Manager window shown in Section 5.1, select Ubiquity Services ➔ SIP_AS_72 ➔ Connected to SIP A/S Management Server ➔ Service Host Collection. Click the SOOF tab. Click Alias (on the left-hand side within the SOOF tab). In the SOOF Components frame, select “service_components” and click Configure. Then click Import.
The **Open** dialogue is displayed. For this sample configuration, the bundled “services_components.sar” service is used. Therefore, per Reference [8], the alias file that must be used is the “single_sar_service_components.alias” file. This file is placed in the “alias” sub-folder where the Service Components files were installed. In this sample configuration, the alias file is located in the “C:\USCL\ServiceComponents-1.5.2\alias\” folder. If the Service Components were deployed as individual services, a different alias file would be used. Browse to the above alias file and click **Open**.

The aliases that were imported from the alias file are now displayed in the **Aliases** frame in the **SOOF** tab. Click **Apply**.
5.3.2. Configure Open Web Services Aliases
Repeat the steps in Section 5.3.1 to configure the aliases for Open Web Services. Select “parlayx_components” in the SOOF Components frame instead of “service_components”. For this sample configuration, the bundled Open Web Services service file is used. Therefore, per Reference [10], the alias file that must be used is the “components.alias” file. This file is placed in the “alias” sub-folder where the OWS files were installed. In this sample configuration, the alias file is located in the “C:\ USCL\OpenWebServices-AddPack-1.1.0\alias\” folder. If the Open Web Services were deployed as individual services, a different alias file would be used.

6. Third Party Call Control Service Configuration
Once the Avaya SIP A/S Open Web Services in Section 5 have been deployed and configured, client applications such as Click2Call can use the following web service URL to invoke methods on the Third Party Call Control web service supported by Open Web Services:

- http://<Avaya SIP A/S address>:6060/parlayx_components/ThirdPartyCall

In this sample configuration, “<Avaya SIP A/S address>” was replaced with the domain of Avaya SIP A/S as shown in Section 5.1. The web service URL was as follows. This URL was used by the Click2Call application as shown in Section 7.1.

- http://isvsipas.com:6060/parlayx_components/ThirdPartyCall

Note that “parlayx_components” was used as the parlayx_components.sar service that was deployed in Section 5.2.3.

7. Inova IT SIP Objects.NET and Inova IT Click2Call Configuration
The SIP Objects.NET framework is a development platform that allows development and deployment of applications to use services provided by OWS. The Click2Call application accesses these services via SO.NET. A SO.NET Windows Dynamic Linked Library (DLL) is installed with Click2Call. Additional information on using and developing applications with SO.NET is available in References [11] and [13].

The Click2Call application can be used with Microsoft Internet Explorer and Microsoft Office applications. For this configuration, Microsoft Internet Explorer, Microsoft Excel, and Microsoft Word were used. Microsoft PowerPoint and Microsoft Outlook Mail are also supported but were not tested. As the tested version of the Click2Call application does not support Microsoft Outlook Contacts, the Microsoft Outlook Contacts application was not tested.
This section focuses on the procedures to install and configure the Click2Call application and to configure the Microsoft applications to work with the Click2Call application. The procedures are as follows:

- Install Click2Call
- Configure Click2Call settings in Microsoft Internet Explorer
- Configure Click2Call settings in Microsoft Excel
- Configure Click2Call settings in Microsoft Word

**NOTE:** The Click2Call application requires that the Third Party Call Control service is installed. For this configuration, this service was installed as part of Open Web Services in Section 5.2.3.

### 7.1. Install Inova IT Click2Call

As part of the installation of the Click2Call application, the user must provide a telephone number, the web services URL being hosted by Avaya SIP A/S, and the gateway provided through Avaya SES. In the **Customer Information** installation window, enter the following values for the specified fields and click **Next** to continue with the installation.

- **My Phone Number:** Mobile telephone number, in E.164 format [14]; telephone numbers for Home and Work can be added in Section 7.2.1.
- **PSTN Gateway:** “isavbc.com”; domain name for Avaya SES from Section Error! Reference source not found..
- **Open Web Services Third Party Call Url:** “http://isvsipas.com:6060/parlayx_components/ThirdPartyCall” as defined in Section 6.
7.2. Configure Microsoft Internet Explorer

This section focuses on the procedures to configure Microsoft Internet Explorer to work with the Click2Call application. It is assumed that Microsoft Internet Explorer is already installed. The procedures are as follows:

- Configure Click2Call settings (work and home telephone numbers)
- Enable Click2Call
- Select country
- Select calling party telephone number

7.2.1. Configure Click2Call Settings (Work and Home Telephone Numbers)

After the Click2Call application is installed, a Click2Call toolbar is installed in the Microsoft Internet Explorer window. Home and Work telephone numbers must be configured.

Start Microsoft Internet Explorer (Start ➔ Programs ➔ Internet Explorer). The Windows Internet Explorer window is displayed. For this configuration, a blank page was displayed and the Click2Call toolbar is shown. The Internet Explorer window may look different depending on how Microsoft Internet Explorer was configured. The following controls are displayed in the Click2Call toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Enable/Disable</td>
</tr>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Settings</td>
</tr>
<tr>
<td><img src="image" alt="United States" /></td>
<td>Country</td>
</tr>
<tr>
<td><img src="image" alt="Mobile" /></td>
<td>Calling Party Telephone</td>
</tr>
</tbody>
</table>

Table 2: Click2Call Toolbar

Click the **Settings** toolbar button (see Table 2).
The Click2Call – Settings dialogue is displayed. Note that the fields Mobile (under My Telephone Numbers), Address (under Dialing Out), and URL (under OWS Gateway (SIP A/S)) are populated with the values from the Customer Information window in Section 7.1 for the fields My Phone Number, PSTN Gateway, and Open Web Services Third Party Call URL, respectively. Enter the following values for the specified fields and retain the default values for all remaining fields. Click OK.

- **Work**: Work telephone number, in E.164 format [14].
- **Home**: Home telephone number, in E.164 format.

![Click2Call Settings Dialogue](image)

**NOTE**: These updated settings apply to all of the Microsoft applications.

### 7.2.2. Enable Click2Call

Enable Click2Call to be used with Microsoft Internet Explorer. Mouse over the Click2Call Enable/Disable toolbar button shown in Table 2. If Click2Call is enabled, the pop-up text “Turn Click2Call Off” is displayed. If not, click the Enable/Disable toolbar button to enable Click2Call.

![Enable/Disable Click2Call](image)
7.2.3. Select Country
Select the country setting for use with Click2Call. Click the Click2Call Country toolbar button (see Table 2) and select the desired country from the pull-down list. For this configuration, “United States” is selected (see the Windows Internet Explorer window in Section 7.2.2).

7.2.4. Select Calling Party Telephone Number
Select the telephone that will be used as the calling party. Click the Click2Call Calling Party Telephone toolbar button (see Table 2) and select “Work”, “Mobile”, or “Home”. The default is “Mobile” as is selected for this configuration. The numbers associated with these selections are defined in the Settings dialogue shown in Section 7.2.1.

7.3. Configure Microsoft Excel
This section focuses on the procedures to configure Microsoft Excel to work with the Click2Call application. It is assumed that Microsoft Excel is already installed. It is also assumed that the Click2Call settings are already configured (see Section 7.2.1). The procedures are as follows:

- Enable Click2Call
- Select country
- Select calling party telephone number
- Enable smart tags

7.3.1. Enable Click2Call
Start Microsoft Excel (Start → Programs → Microsoft Office → Microsoft Office Excel 2003). NOTE: This may vary depending on how Microsoft Excel was installed and the version of Microsoft Excel. The Microsoft Excel window is displayed. The Microsoft Excel window may look different depending on how Microsoft Excel was configured. Mouse over the Click2Call Enable/Disable toolbar button shown in Table 2. If Click2Call is enabled, the pop-up text “Turn Click2Call Off” is displayed. If not, click the Enable/Disable toolbar button to enable Click2Call.

7.3.2. Select Country
Select the country setting for use with Click2Call. Click the Click2Call Country toolbar button (see Table 2) and select the desired country from the pull-down list. For this configuration, “United States” is selected (see the Microsoft Excel window in Section 7.3.1).
7.3.3. Select Calling Party Telephone Number

Select the telephone that will be used as the calling party. Click the Click2Call Calling Party Telephone toolbar button (see Table 2) and select Work”, “Mobile”, or “Home”. The default is “Mobile” as is selected for this configuration. The numbers associated with these selections are defined in the Settings dialogue shown in Section 7.2.1.

7.3.4. Enable Smart Tags

From the main menu, select Tools → AutoCorrect Options. Select the Smart Tags tab. Check the Label data with smart tags check-box to enable the Recognizers frame. Check the Click2Call Address (Inova IT Click2Call) check-box. Retain the default values for all remaining fields. Click OK.
7.4. Configure Microsoft Word

This section focuses on the procedures to configure Microsoft Word to work with the Click2Call application. It is assumed that Microsoft Word is already installed. It is also assumed that the Click2Call settings are already configured (see Section 7.2.1). The procedures are as follows.

- Enable Click2Call
- Select country
- Select calling party telephone number
- Enable smart tags

7.4.1. Enable Click2Call

Start Microsoft Word (Start → Programs → Microsoft Office → Microsoft Office Word 2003). NOTE: This may vary depending on how Microsoft Word was installed and the version of Microsoft Word. The Microsoft Word window is displayed. The Microsoft Word window may look different depending on how Microsoft Word was configured. Mouse over the Click2Call Enable/Disable toolbar button shown in Table 2. If Click2Call is enabled, the pop-up text “Turn Click2Call Off” is displayed. If not, click the Enable/Disable toolbar button to enable Click2Call.

7.4.2. Select Country

Select the country setting for use with Click2Call. Click the Click2Call Country toolbar button (see Table 2) and select the desired country from the pull-down list. For this configuration, “United States” is selected (see the Microsoft Word window in Section 7.4.1).

7.4.3. Select Calling Party Telephone Number

Select the telephone that will be used as the calling party. Click the Click2Call Calling Party Telephone toolbar button (see Table 2) and select Work”, “Mobile”, or “Home”. The default is “Mobile” as is selected for this configuration. The numbers associated with these selections are defined in the Settings dialogue shown in Section 7.2.1.
7.4.4. Enable Smart Tags

From the main menu, select Tools → AutoCorrect Options. Select the Smart Tags tab. Check the Label text with smart tags check-box to enable the Recognizers frame. Check the Click2Call Address (Inova IT Click2Call) check-box. Retain the default values for all remaining fields. Click OK.
8. Interoperability Compliance Testing

This section describes the compliance testing used to verify the interoperability of Inova IT SIP Objects.NET and the Inova IT Click2Call application to work with an environment comprised of Avaya SIP A/S, Avaya Communication Manager, and Avaya SES. This section covers the general test approach and the test results.

8.1. General Test Approach

The general test approach was to use the Click2Call application to generate calls using all combinations of the endpoints connected to or registered with Avaya Communication or Avaya SES (including those endpoints connected to the PSTN).

8.2. Test Results

Inova IT SIP Objects.NET and Inova IT Click2Call passed compliance testing. The following functionality was verified. Any observations related to these tests are listed below.

- Using G.711 µ-law and G.729 media codecs, calls were made using the Click2Call application running in Microsoft Internet Explorer using each type of endpoint (Digital, H.323, SIP, and PSTN) as the calling party endpoint and each type of endpoint as the called party.
- Using G.711 µ-law and G.729 media codecs, calls were made using the Click2Call application running in Microsoft Excel using each type of endpoint (Digital, H.323, SIP, and PSTN) as the calling party endpoint and each type of endpoint as the called party.
- Using G.711 µ-law and G.729 media codecs, calls were made using the Click2Call application running in Microsoft Word using each type of endpoint (Digital, H.323, SIP, and PSTN) as the calling party endpoint and each type of endpoint as the called party.
- Proper display of the calling party name information was verified for only the Avaya 4600 Series IP Telephones running the SIP software. Per the limitation described in Section 9.2, all other endpoints displayed the name of the trunk administered in Avaya Communication Manager. In this case, the calling party name is “Avaya SIP A/S 150.1.1.161”, the name of the trunk used for calls to and from Avaya SIP A/S.
9. Verification Steps

This section provides the tests that can be performed on Avaya Communication Manager and on Avaya SIP A/S to verify proper configuration of Avaya Communication Manager, Avaya SES, and Avaya SIP A/S.

9.1. Verify Avaya Communication Manager

9.1.1. Verify Idle Trunk and Signaling Groups

Verify the status of the SIP trunk group by using the “status trunk n” command, where “n” is the trunk group number administered in Section 3.1. Verify that all trunks are in the “in-service” state as shown below. For this sample configuration, as no calls were present on this trunk, the state of all of the trunk members was “in-service/idle”.

```
status trunk 3

TRUNK GROUP STATUS

<table>
<thead>
<tr>
<th>Member</th>
<th>Port</th>
<th>Service State</th>
<th>Mtce Connected Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>0003/001</td>
<td>T00101</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/002</td>
<td>T00102</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/003</td>
<td>T00103</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/004</td>
<td>T00104</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/005</td>
<td>T00105</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/006</td>
<td>T00106</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/007</td>
<td>T00107</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/008</td>
<td>T00108</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/009</td>
<td>T00109</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
<tr>
<td>0003/010</td>
<td>T00110</td>
<td>in-service/idle</td>
<td>no</td>
</tr>
</tbody>
</table>
```

Verify the status of the SIP signaling group by using the “status signaling-group n” command, where “n” is the signaling group number administered in Section 3.1. Verify that the signaling group is “in-service” as indicated in the Group State field shown below.

```
status signaling-group 3

STATUS SIGNALING GROUP

Group ID: 3
Group Type: sip
Signaling Type: facility associated signaling
Group State: in-service
```

Active NCA-TSC Count: 0
Active CA-TSC Count: 0
9.1.2. Verify Active Trunk Group

9.1.2.1 Verify Active Trunk Group with Microsoft Internet Explorer

Using the Click2Call application running in Microsoft Internet Explorer, make a call originating from SIP endpoint “26003” to H.323 endpoint “30001”.

Start Microsoft Internet Explorer (Start ➔ Programs ➔ Internet Explorer). The Windows Internet Explorer window is displayed. In the URL field, enter a web page address that has a telephone number (in E.164 format) that can be used to dial a telephone that exists within the configuration. For this example, the URL “http://150.1.1.170/testdial.htm” was entered. This web page was created for this test configuration and includes a list of numbers that were used to call the telephones in the configuration. The web page used for other configurations will be different.

Click the Calling Party Telephone Click2Call toolbar button (see Table 2) and select “Mobile”. As shown in Section 7.2.1, the telephone number for “Mobile” is “+1 732 852 6003”. Per the digit manipulation rules in Section 3.2, this number will be dialed by Avaya Communication Manager as “26003”. Click on the “732 853 0001” link. Per the digit manipulation rules, this number will be dialed by Avaya Communication Manager as “30001”.

![Image of Windows Internet Explorer window with Click2Call toolbar and list of numbers]
The Click2Call – Dialing Out dialogue box is displayed. Note that the dialogue box shows that “+17328530001” is about to be dialed. Retain the default values for all of the fields and click OK to make the call.

The Click2Call – Call Details dialogue box is displayed showing the calling party number (Caller) and the called party number (Callee).
Answer the call made to “26003” and then answer the call made to “30001”. Verify the status of the SIP trunk group by using the “status trunk n” command, where “n” is the trunk group number administered in Section 3.1. Verify that there are two trunk group members that are in the “in-service/active” state as shown below. In this configuration, two calls were generated by Avaya SIP A/S.

<table>
<thead>
<tr>
<th>Member</th>
<th>Port</th>
<th>Service State</th>
<th>Mtce Connected Ports</th>
<th>Busy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0003/001</td>
<td>T00101</td>
<td>in-service/active</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/002</td>
<td>T00102</td>
<td>in-service/active</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/003</td>
<td>T00103</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/004</td>
<td>T00104</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/005</td>
<td>T00105</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/006</td>
<td>T00106</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/007</td>
<td>T00107</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/008</td>
<td>T00108</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/009</td>
<td>T00109</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>0003/010</td>
<td>T00110</td>
<td>in-service/idle</td>
<td>no</td>
<td></td>
</tr>
</tbody>
</table>

Verify the status of one of the connected SIP trunk group members by using the command “status trunk x/y”, where “x” is the number of the SIP trunk group from Section 3.1 for calls from Avaya SIP A/S, and “y” is the member number of a connected trunk. Verify that the Service State is “in-service/active” and that Audio Connection Type displays “ip-direct” which indicates that media shuffling is enabled.

<table>
<thead>
<tr>
<th>Trunk Group/Member: 0003/001</th>
<th>Service State: in-service/active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port: T00101</td>
<td>Maintenance Busy? no</td>
</tr>
<tr>
<td>Signaling Group ID:</td>
<td></td>
</tr>
<tr>
<td>IGAR Connection? no</td>
<td></td>
</tr>
<tr>
<td>Connected Ports: T0011</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Port</th>
<th>Near-end IP Addr : Port</th>
<th>Far-end IP Addr : Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signaling: 01A0017</td>
<td>150. 1. 1.100 : 5061</td>
<td>150. 1. 1.150 : 5061</td>
</tr>
<tr>
<td>G.711MU  Audio:</td>
<td>150. 1. 1.207 : 5004</td>
<td>150. 1. 1.231 : 2970</td>
</tr>
<tr>
<td>Video:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Codec:</td>
<td></td>
<td>Authentication Type: None</td>
</tr>
</tbody>
</table>

Audio Connection Type: ip-direct
9.1.2.2 Verify Active Trunk Group with Microsoft Word

In Section 9.1.2.1, instructions are provided for Microsoft Internet Explorer. The same verification steps apply when using Microsoft Word or Microsoft Excel. As an alternative, this section covers making the call using Microsoft Word. The instructions for Microsoft Excel are similar and are not shown.

Start Microsoft Word (Start ⇒ Programs ⇒ Microsoft Office ⇒ Microsoft Office Word 2003). The Microsoft Word window is displayed. In this case, a blank Microsoft Word document is opened. Click the Calling Party Telephone Click2Call toolbar button (see Table 2) and select “Mobile”. As shown in Section 7.2.1, the telephone number for “Mobile” is “+1 732 852 6003”. Per the digit manipulation rules in Section 3.2, this number will be dialed by Avaya Communication Manager as “26003”. In the Microsoft Word edit area, enter “732 853 0001”. Per the digit manipulation rules, this number will be dialed by Avaya Communication Manager as “30001”. Click on the pull-down list button that is displayed under the “732 853 0001” text to open the Click2Call Address: 732 853 0001 pop-up menu. Click on Call this number using Click2Call.

As shown in Section 9.1.2.1, the Click2Call – Dialing Out dialogue box is displayed followed by the Click2Call – Call Details dialogue before the call is completed. The verification steps in Section 9.1.2.1 also apply.
9.2. Verify Avaya SIP A/S

Verify that Avaya SIP A/S has been configured properly to support the Third Party Call Control service, via the Open Web Services installed in Section 5.2.3, and the Click2Call application.

As shown in Section 9.1.2.1, use Microsoft Internet Explorer to make a call. Use “Work” as the calling party telephone (“+1 732 852 6005”) and this time make a call to SIP endpoint “26003” (Avaya 4621SW IP Telephone running the SIP software). Verify that the name on the display for endpoint “26003” is “CallingPartyFromAddr” for calling party name and “CallingPartyFromAddr@isvubi.com” for calling party number. NOTE: The calling party name shown on the display for endpoint “26003” (Avaya 9630 IP Telephone running the Avaya one-X Deskphone SIP software) is the name of trunk configured in Section 3.1 (“Avaya SIP A/S 150.1.1.161”).

Repeat the scenario with “26003” as the calling party and “26005” as the called party. As an alternative, use Microsoft Word to make the call as shown in Section 9.1.2.2. Verify that the name received on the display for endpoint “26005” is “FromAddr” for calling party name and “FromAddr@isvubi.com” for calling party number. The calling party name on the display for endpoint “26003” still shows the name of the trunk.

Only the Avaya 4600 Series IP Telephone running the SIP software shows the proper calling party or called party information as defined in Section 5.2.3. This telephone gathers the information from the SIP “From” header. In the case of the other telephones, including the Avaya 9600 Series IP Telephones running the SIP software, Avaya Communication Manager determines the information that is displayed on the endpoint display. Avaya Communication Manager expects that the SIP “From” header includes both a display name in addition to the SIP URI, e.g., ‘“John Doe” <sip:JohnDoe@isvsipas.com>’. If the display name does not exist, Avaya Communication Manager uses the name of the trunk used for calls from Avaya SIP A/S (see Section 3.1) for the calling party and called party information (in this case, “Avaya SIP A/S 150.1.1.161”).

10. Support

For technical support on Inova IT SIP Objects.NET and Inova IT Click2Call, contact Inova IT at the following:

- +386 2 2294 273
- http://www.inova.si/services.html

11. Conclusion

These Application Notes have described the steps to configure Avaya SIP A/S, Avaya Communication Manager, and Avaya SES to support the Inova IT Click2Call 1.3.187 application. The Click2Call application is built on top of the Inova IT SIP Objects.NET framework. The only interoperability issue to note is that when calls are made by Click2Call, the proper calling party information is only displayed on the Avaya 4600 Series IP Telephones running the SIP software. For all other endpoints, the trunk group name is displayed as the calling party name. This is due to the limitation covered in Section 9.2.
12. Additional References
This section references the product documentation relevant to these Application Notes.


